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® 41 MS POWERPOINT : INTRODUCTION TO POWERPOINT

_ Presentation software is an application software used to make presentations.

“1ese days many presentation software like Microsoft PowerPoint, Open
Oﬂice.org Impress (Open source), Side Rocket are available in market. In this
chapter we will discuss PowerPoint in detail.
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gram developed by Microsoft. It allows yo

PowerPoint is presentation pro .
to create lively and effective presentations. PowerPoint has many easy-to-use,
presentations very quickly anq

predefined layouts and themes to make
easily.
Starting PowerPoint
To work with PowerPoint first of all you have to open it. There are three
ways to open PowerPoint :
(i) Through Start button
(it) Through Search box

(iii) Through shortcut on Desktop
(i) Through Start button : The steps to start PowerPoint through Start

button are given below :
1. Click on the Start button.
2. Click on All Programs
3. Click on Microsoft Office
4. Click on Microsoft Office PowerPoint 2010
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|
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| & 17.1.5. OCR Registation £3 Microscft Office Oreiote 2007
: 3 Maosolt

Office 2010 Todks
8 Microcoft PowerPont 201

Fig. Opening PowerPoint
The PowerPoint window will open up and appear on the screen.
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(i) Click on Search Box : Click Start - Search button.

@ Google Chrome
A;%obo Photoshop

All Programs D CIRun.
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Iig. Displaying Searching option

(it) Click on All files and Folders as shown in diagram (Sub menu of Search),
type PowerPoint and Click to Search Button.
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U5 MathType Addin (PowerPoint ... C:\MathTypel,.. o BI3/1999 4141 AM
AgllintroducngPowerPont 2007 C:\Program Fi... e 9/16/2006 8:23 PM
Ci\Program Fi. .. /26/2016 10:17
PowerPontMU] Ci\Program FA. ., 5/26/2016 10:16
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I"ig. Displaying Searching of PowerPoint

The PowerPoint windows will open up and appear on the screen.

-
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: gii) Thf'ough shorteut on Desktop : You can also open PowerPoint frop,
Pes top. If its shorteut is placed on the desktop then double click on its shortey, -
owerPoint windows will open up and appear on the screen. i

Fig. Steps for opening PowerPoint through icon on Desktop
@ 4.2 CREATING, SAVING, OPENING PRESENTATION

4.2.1 Creating a presentation

Slide is a single or individual page of presentation. There are many methods
to create presentation in PowerPoint. They are given below :

(i) Blank presentation
(i) Recent templates

(iii) Sample templates

(iv) Themes
(v) My templates

(vi) New from existing
112 (oth)
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Fig. Showing different ways to create PowerPoint Presentation

(i) Blank Presentation : When you create a presentation using Blank
Presentation option, a slide with a blank background will appear in the

- PowerPoint window. You can add text, graphics, audio and video to it.

Different methods to create Blank Presentation :
1. Click on File menu — New
Or
Press Ctrl + N from keyboard.
2. Under Available templates and themes, select template/theme.

3. Then press Enter button.

(ii) Insert New Slide

Perform the following steps to Add a new slide :
1. On the Home tab, in the Slides group, click New Slide.
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Fig. Showing different types of Slides
2. Choose a slide thumbnail from the layout gallery.

(ii) Recent Template : You can also create a presentation by using a
recently used template. For this do the following:

(@) Click File > New
(ii) Under Available templates and themes, click on Recent templates.

(iii) Select the desired template and Press Enter.

ol RN 2K Presentationl - Microsoft PowerPoint m@aﬂ
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Fig. Showing Recent Template
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(i) Sample Templates : You can also make a presentation with the help
of sample templates. You can even download more templates from internet.

' Steps to create a presentation using Sample Templates are :
() Click on File menu — New.

(1)) Under Available templates and themes, select Sample templates icon.
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Fig. Showing Sample templates icon

(117) Select the Sample template of your choice and press enter or click
Create button.
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Fig. Showzng different Sample Templates
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(ii) Under Available templates and themes, select Themes.
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Fig. Showing Themes icon

(iii) Select the theme of your choice and press enter.
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(vi) To create presentation through New from existing :
1. Click File - New.

2. Under Available templates and themes, click on New from existing.

3. Select the desired existing template and press Enter.

New from Existing Presentation

|2 Recent ¥o-aXx. 3
RN Size Type Modified ~
- lintroducing 17111 KB Microsoft Powe... 1/12/2015 10:...
, & Presentationd 51 KB Microsoft Powe... 1/12/2015 10:...
" &) AP PUBLISHERS 71 KB Microsoft Powe... 1/11/2015 2....
!:‘m glnformatin technology File Folder 1/7/2015 7:3...
Desktop Shortout 1/7/2015 7:1...
Computer
Network | |39 My Documents System Folder  1/7/2015 1:4...
’Mv
Pleces | 133 Shared Documents 1/6/2015 11:...
# Local Disk (D) 1/6/2015 11:...
| |8 Downloads File Folder 1/5/20156:1...
| ;[a.) Shared Documents (2) 1/3/20154:4...
éfLocal Disk (C) 12/31/2014 4.... |
u-)My Documents (2) System Folder ~ 12/13/2014 10... ;8
luCORAL 15 File Folder 12/5/20145.... @
83 Administrator File Folder 11/24/2014 11... i
14’9 File Folder 11/19/2014 7439 g !
el — 8
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(Caesenen J [cones |

Fig. Showing New from Existing Presentation dialog box
4.2.2 Save Presentation

After making your presentation, you can save it for future use. A
presentation can be saved in many ways. Following are some ways to save a
. presentation :

| 1. Through File Menu. or
| 2. By clicking Save button on Quick Access Toolbar. or
3. By Pressing Crtl + S on keyboard

o) [117]
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Fig. Displaying Save option
2. Save As dialog box will appear. Enter the File Name for the presentation

and Click on Save button. You can also save your presentation in another drive
or folder. To do this, select the drive or folder from the dropdown list of Save

in box.
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Fig. Displaying Save As dialog box showing File Name “Sunil”
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he presentation to be opened.

-j(i) Click on File menu.

Perform the following steps to open Existing presentation :

.

el save

v s

Info

| & open
(= close

o

Fig. Displaying File Menu
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Fig. Displaying Open dialog box
(22) Click Open and open dialog box will appear.

(111) Type the name of the presentation to be opened in the File name box
and click on open button. The presentation will open in PowerPoint window.

4.2.4 Exiting Powerpoint

When you have done your work in PowerPoint and save

Exit PowerPoint.

(9th)
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The steps to exit from PowerPoint are :
Perform the following steps to exit PowerPoint.
1. Click on File menu — Select Exit option.
Or
Click on Close button which is present on the right side of the title by,

et Ciose Minimize Maximize  Close

= \ | /
o

Print
\

B -, gcos 4

[ t; ::fk
Fig. Exit option Fig. Displaying Minimize/Maximize/Close option
Or

Press Alt + F4 keys together from keyboard.
& 4.3 CONCEPT OF SLIDE SHOW, BASIC ELEMENT OF SLIDE

4.3.1 Slide And Presentation

Slide : A presentation is made of many slides. A slide is a single or |
individual page of a presentation. It is just like 35mm film based slide. Slides
may contain text, graphics, audio/video, and other objects, which may be “
arranged freely on the slide. You can also add text, graphics, photos, clip art,
sound and video to your slides.

Presentation : A presentation is a collection of individual slides that

contain information on a topic. PowerPoint presentations are most commonly
used in business meetings and for training and educational purposes. You can
add animation effect, audio/video clips in slides to make effective presentation-

ts, notes

In other words, a presentation is a combination of slides, handou
and outlines all in one file.
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sert New Slide

Perform the following steps to Add a new slide :
- 1. On the Home tab, in the Slides group, click New Slide. Or
- Press Ctrl + M to insert New Slide

Fig. Showing different types of Slides

2. Choose a slide thumbnail from the layout gallery.

® 4.4 DIFFERENT ELEMENTS OF SLIDE LAYOUT

(i) Layout : "Layout" refers to the way things are arranged on a slide. A
layout contains placeholders. Placeholders contains text such as titles and
bulleted lists and slide content such as tables, charts, pictures, shapes, and
clip art. Slide layout pane may contain following types of slides :

1. Tables, 2. Chart, 3. Clip Art, 4. Media clip, 5. Smart Art, 6. Picture

Click to add title

Chck 10 odd tomt Clak 10 0dd tomt
» Click to add * Cw e
text
-'.“p
P

Fig. Displaying Title and Content Layout
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When you add a new slide the slide layout will open automatically, Ch%se

the layout of the slide according to the content of the slide. For examp it
you want to show comparison of two things on a slide, then you shoylq select
Comparison layout from Layout pane.

Perform the following steps to apply Slide layout :

1. Click on Home ribbon

2. Select Layout tool and a pull down list will display.
3. Choose the required layout and press Enter button.

! A A LS
|g.». Offce Theme.
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|\
Ton et T Tt Oy
i ;
B =]
== |
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Fig. Displaying different Slide Layout

PowerPoint window has File menu, Menu bar tab, Ribbons, Slide Pane, Note
pane, Status Bar, Slide tab.

Quick Access Toolbar (QAT) Erpgrai lvil
ck Access :
Title bar : control buttons
"f Rxb/bonTabs e
Filetab &% 04+ Presentation "Microsoh PowerPoint / =@ 83
\--—o—._——-—‘-u-—— BT}
- | = A . 1
TR A 5 o AN S .o i & A i
ijboﬂ[-:; :-J._::- BlIUSw® o A Exan B ; g}; ‘f "_‘" |
™ ¢ =3 o Aot o g

e

I i i BT

Click to add title

Cick to add subtitie

Notes pane
View Buttons

Fig. Showing Parts of PowerPoint Window
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f * Fig. File menu
- 2. Quick Access Toolbar : It is located above the File menu. It has three

- buttons: Save as, Undo, Redo. It is a customize toolbar and you can add any
~ button to it that you require frequently.

' Customize Quick Access Toolar

Miore Commanas..
Show Seiow the Ridbon

Fig. Customize Quick Access Toolbar
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3. Menu Bar Tab : Each menu bar tab is task oriented and openg the rij
that is divided into subtasks. bon

Il 0

Presentationl - Microsoft PowerPoint =5
-mmmrmmummn-x 4
L Menu Bar i

Fig. Menu Bar

4. Ribbons :
that tab.

I.m M9 0l o e e

Ribbon shows the tools and commands that are Present
n

) ‘13 < [.:]a‘w. 1 «“AA P i® e ‘.‘
Ribbon| | s ™ . Bifese o ABl 2 = B
| Omcenon-| B I LS oA ESEm N 5
- SR SSSSIESEES—— WU, S ...
Flg Ribbon

Different types of Ribbons and their function :

Home : It contains all the features related to Clipboard, Slides, Font,

Paragraph, Drawing and Editing.

by

‘ l'f A l-,' i Layou - ¥ “AA | Y= i i = i ?
s ‘2 ‘W 3 d 3

| Paste o s::-. A Bl U SN -aA]v A-EEWER B by
Clipboard '+ Shdes Font Paragraph
Insert :

It helps to insert Tables, Images, Illustrations, L1nks, Text
Symbols, and Media.

ECERCF W Presentation] - Microsoft PowerPoint D@S.zl
‘m Insert  Design  Transtions  Animations  Siide Show  Review  View

E”“'mﬂﬁﬁﬂ&"-ﬁdmﬂﬂﬁi

Table Pictwre Clip Screenshot Photo  Shapes SmartAnt Chant ypetiok Action  Text  Header WordAn Eoulon ymber  Video Audio

e At v Aoume - Box & Footer .

E'““ images liustrations Links Tent Symbols Mecia

Design : It contains all feature related to Page Setup, Themes, Background.

-mmmrmmmmmm "g

- : Ecoos - y
u ﬁ Aa Aa Aa Aa | . ) A tecigroma seves
2 |l = -
Setup Or !

Themes

= [.][!Iom . [ Hide Background Graphics

Page Setup

Background
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Slide Show : It helps to start slide show and to set up Rehearse Timings
‘and Monitor setting etc.

Home Inset Design Transitions  Animations ”’“'WA“__'!.; - A ':'_;‘-‘-lﬂ':"vr‘ -
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Review : It has features like Proofing, Language, Comments and Compare.
]

Wome imen Desgn Tmtons Anmations SideShow  Review | View

Vi@ % % aamu* 3@'

Spetling Research Thetauns rmunu Language  Show Fan Delete Previous Next  Compare Accept  Heject
Markugp Cmnl_onnmi .

Proofing Language Comments.

USSR Sra | . Compare.

X
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Format : When you write any text then a new tab named "Formggn is :
displayed which has options like Insert Shapes, Shape Styles, WordArt Styleg

Arrange and Size. :

A\\NOoa@ - % e e Gt A avngromas~ - o m‘g
N = ==
AN Ik . @oacettes s cog- Biw  Tyseeaomime 5 s s

‘ Iert Shapes Shape Styles % WoedArt Styles Arange Sze

Note pane : It is used to enter speaker notes.
; {Note pane
[ |ty re——————— . —
i (o] Click to 2dd notes
| : " ‘ P T A mmm;&-..ﬂaﬂg
Status bar : It has view option and also allow you to zoom in and zoom

out.
- e -
'lWMJ“WW‘*_Q
Status bar Zoon in Zoon out

Slide tab/Pane : It shows the thumbnails of the slide and it also shows
the order of slides in the entire presentation.

Slide pane

& 4.5 DIFFERENT TYPES OF VIEW OF A SLIDE
(NORMAL,SLIDE SORTER AND SLIDE SHOW)

4.5.1 Views Of Powerpoint

View is way of displaying the contents of a presentation. PowerPoint allows
you to view your slides in different ways. This can be done with the help of
various views of PowerPoint. Views make it easier to manage the content of
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your presentation. It also allows you to add notes to the slides in your
presentation which are helpful for creating handouts.

Slide Show :
To exit Slide Show view : Press Esc button.

1. Normal View : Normal view is the default and main editing view. In

this view you create and design your presentation. Normal view includes the 31
Slides/Outline pane on the left.

Presentationl - Microsoft PowerPoint = [B §3 {

Design  Transitions ~ Animations  Slide Show  Review  View < e

——— - T T

Click to add title ‘ ;

Click to add subtitle o

{
‘ . |
Normal view i

Fig. Normal View

3 2. 5lide sorter view : Slide sorter view is very useful view of PowerPoint. :
Slide sorter gives you an overall picture of your presentation. In this view, i
you see a miniature (thumbnail form) of each slide. The Slide Sorter view allows i

Jfk You to sort, rearrange and hide your slides. You can add, or delete slides in _
o'k this view. You can also preview your transition and animation effects in this »‘
ok view. You can not view, edit the text or images on the slide.
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Slide Sorter View

Fig. Slide Sorter View

3. Notes Page : This view is used to add notes related to the contents of :
slide. The slide selected in this view appears on the top corner and the notes |
related to slide can be written at the bottom portion. These notes are printable
and you can give them to the audience.

Note pane

| : | Clickto add notes {

Fig. Displaying Notes Pane

4. Reading view : It display the slide within the window and this view i8
used to do proof reading. This view is not used to give presentation to audience.

5. Master views : It includes Slide, Handout and Notes view. In main slides
it stores information about the presentation, including background, color, fonts
effects, place holder sizes & positions. In this view you can make unive
style changes to every slide, notes page or handout associated with you*

presentation.
ks




" ¢ 4.6 EDITING AND FORMATTING OF SLIDE

You can also change the Pattern or Texture of the background. You can also
use pictures as the background of the slide. You can change the pattern and
texture from the Background Styles button.

The steps to change the Pattern as Picture are given below :

1. Click on Background Styles button on the Design tab.

Design Tab Background Styles

—— e SRS, A Sa o wtm o Y FO—
ﬂe(senmionl - Microsoft PowerPoint Oiaing ToL| =B &3 "J-—-—-L——L'iﬂ
Design ~ Trangitions  Animations  Stide Show  Review  View Format [~ o_j

‘ n(o-f:n =
e~ e
L - S— « [@ !1‘[ i

..............

{:‘-l, A+ 19

A e |

H.BEJ; = M‘é;

Fig. Displaying Background Styles

2. Click on Format Background. Format Background dialog box will appear
on the screen.

. ! Fil
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Fig. Format Background
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appear on the screen.
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Fig. Steps for Changing Picture
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6. Select the desired Picture.

Esd -

7. Click on Insert button from the dialog box.

8. Click on Close button to apply this picture on selected slide or Apply to
All button to apply this picture on all the slides in the presentation.

Home Inset Design  Transitons  Animations  Slide Show  Review Q 9_

nr e i 'Eeutqvtumﬁ Styles v !

j = L4 A G Aa Aronts - |

| Page Slide ! » [—— we @wa Sl ettects » 71 Hide Background Graphics | |
Background :

Setup Onentation ~

Page $ etup

lay

8803003 | Awes |5 | ——— Y Y Ye s wr——cs .
Fig. Changing picture in slide

The selected picture will be applied to your slide/slides.
The steps to change the Texture are given below :

1. Click on Background Styles button on the Design Ribbon.

Design Menu
Home  lmert  Oevign  Traodtions  Anmations  Side Show Review View A e Background
B ST e
| i e

=i ;"'"_"‘" ﬁmmlmlu Tat Backgrennd

B Formu kg
®) Beset Siice Backgroun

Fig. Steps for Changing Background Styles
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2. Click on Format Background. Format Background dialog hoy will 4
on the screen. s

Format Background 7 X
™ -
|| Fill
Pichure Correctons ® sl M
Picture Color | O @adent M
Artistc Cffects O picture or texture f
| O Pattern M
| ‘ (] t9de background graphics
| ; Pl Color
oo (53

Transparency: J ‘0* .

B e | T

3. Select Fill option, then select Picture or texture fill option.

Fig. Format Background

4. Click on Texture drop down menu. A drop down list will be displayed.

Different

es of ~

exture

Format Background

. | Fil

Prctre Corrections 5

Pacture Coler ;,r‘:’ ;:~ 5 Picture or
) fradent

At bt | @ Peare or leatre .‘/ texture ﬁ"

‘ O rgiien o
\Du«wmgm

\ Texture option

Tesye

Fig. Displaying Texture Fill
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5. Select the desired Texture from the list.

6. Click on Close button to apply this Texture on current slide or Apply to
All button to apply this Texture on all the slides in the presentation.

Format Background

L]
Picture Corrections
Picture Color

Artistic Effects

Fill
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([ pe.. ] [omows | [(Gore.. |
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Thng cotens
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Ngrment

B Scae )
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v
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J o B
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Appl}/ to All

wos
0% BB

Top left

Close

Fig. Format Background Dialogue Box
7. The selected texture will be applied to your slide/slides
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Page Slide
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@ 4.7 ADDING TITLE AND SUB TITLES, TEXT,
BACKGROUND, WATER MARK
CHANGING THE BACKGROUND STYLES

You can change the background colour of selected slide or all the slig
a presentation. The steps to change the background style are :

1. Click on Background Styles button on the Design tab.
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2. Move the mouse over any of the background style.

3. The selected background style will be reflected on the slide.
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€ 4.8 HEADER AND FOOTER AND NUMBERING OF SLIDES

PowerPoint offers the ability to add header and footers to the slides. While
having footers in presentations is logical, header may not be quite evident at
first. Typically, the slide title would be the header in the main slide, however

when it comes to printing out handouts a separate header would be quite use-
ful.

Here are the steps to add header and footer information to slides

1. In the Insert ribbon, click on the Header & Footer menu item.
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9. The Header and Footer dialog has two tabs — the Slide tab and the Ny,
and Handouts tab. The slide tab is appear the figure.

Side | Notes and Handouts |
e e
g
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Fixed
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= e
( 7] Don't show on title gide
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3. From the Notes and Handouts option you can add Date and Time in the

footer
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Header : Add the header information for every page on the handout

(9th)




o ,-“*'.h.‘: ,,;_?t‘ BT AT TR ».~ Yag AL =

: ‘Page Number : Insert page number in the footer

‘When you check any of the header and footer checkboxes in either tabs, you
can see the location where the detail is inserted in the preview section.

€ 4.9 INSERTING PICTURES IN SLIDE

Clip Art : PowerPoint has picture gallery which is called Clip Art gallery.
Clip Art is a single piece of ready-made art. Clip Art gallery contains clips of
different categories. It contains clips related to different category like school,
computer, books etc. Perform the following steps to insert Clip Art from gallery:

1. Click on Insert menu — Clip Art option.
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Fig. Displaying Clip Art menu
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